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DISCLAIMER OF WARRANTY

THIS SOFTWARE ("WJS") IS PROVIDED "AS IS" WITHOUT ANY 
WARRANTIES OR CONDITIONS, EXPRESSED OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THOSE CONCERNING MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE.  NEITHER ANGEL BABUDRO NOR ANYONE ELSE 
WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THIS 
SOFTWARE EVEN IF ANGEL BABUDRO HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR CLAIMS.  IN NO EVENT SHALL THE 
AUTHOR'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID FOR 
THE LICENSE TO USE WJS, REGARDLESS OF THE FORM OF CLAIM.  THE 
PERSON USING WJS BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE
OF THE SOFTWARE.

Some States do not allow the exclusion of the limit of liability for 
consequential or incidental damages, so the above limitation may not apply 
to you.

This agreement shall be governed by the State of Colorado and shall 
inure to the benefit of Angel Babudro and any successors, administrators, 
heirs and assigns.  Any action or proceeding brought by either party against 
the other arising out of or related to this agreement shall be brought only in 
a State or Federal Court of competent jurisdiction located in Delta County, 
Colorado.  The parties hereby consent to in personam jurisdiction of said 
courts.

COPYRIGHT

WJS is owned and copyright (c) 1991-1995 by Angel Babudro, all 
rights reserved.  You may only use and/or distribute WJS under the License 
terms below.

LICENSE

The following terms and conditions apply to the use and/or 
distribution of What Job Summary?:

1. WJS is being distributed as Shareware; it is not free.  You are 
granted a limited license to use WJS for an evaluation period of up to 60 
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days, to determine if it suits your needs.  Any other use of WJS or use past 
this period requires registration.

2. You may keep as many backup copies of WJS as you wish.  The 
Registered Edition is limited to simultaneous use on the number of 
computers indicated on the Use License.  The Unregistered Edition may be 
used on any number of computers for the purpose of evaluation as specified 
in paragraph (1).

3. All files originally distributed as part of the package (including this 
notice) must be included without modification.  The complete list of files can 
be found in the PACKING.LST file which is part of this package.  The 
Registered Edition CONFIG.WJS file is NOT to be distributed.

4. Individual users may freely copy this disk and share it with friends, 
family, and acquaintances.  Non-profit groups (including user groups and 
BBSs) may distribute copies of this disk.  A fee of no more than $5 may be 
charged to cover disk copying costs.  If the files on this disk have dates more
than a year old please contact the author for a free update to the current 
version.

5. Disk distributors and dealers must have written permission before 
selling copies of this software.  When you contact me you will receive a free 
copy of the latest version and you will be placed on my mailing list to receive
updates as they are released.  Disk distributors may charge no more than 
$10 per disk for copies of this software.  If, as a distributor, you supply copies
to other resellers, the end price to the user may not exceed $10.

6. You must obtain written permission prior to distribution as part of 
any "bundled" packages (e.g., CD-ROM, placing on new computer systems, 
etc.).  Such permission is often granted; the author is a nice guy - please 
write to him with your ideas.

7. If the software is packaged for retail sale the packaging must 
explain that the software is Shareware, that the purchaser is receiving a trial 
version, and that use beyond the trial period requires registration with the 
author.

8. You must immediately stop selling/distributing copies of this 
software upon notice from the author.
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TECHNICAL SUPPORT (HOW TO REACH ME)

If you have questions or need help, just send a note to me through 
the mail or a BBS listed below.  Registered users, those intending to register 
within 30 days, vendors, and sysops may contact me via telephone as well.  
Sysops and shareware vendors please see VENDOR.DOC for distribution 
information.

Mail Angel Babudro, "Organic Computer Wizardry", Box 132, 
Paonia, CO 81428 USA

Phone (303) 527-6756 Tue-Sat 10am-6pm Mountain Time

I am normally available by phone during the hours stated above.  If 
you get the answering machine please leave a message.  Unregistered users:
please try again later; I am happy to answer your questions but I cannot 
afford to pay for the call.

Official Distribution Bulletin Boards

My software packages are "free" downloads on the BBSs listed below 
- you need not subscribe to download my shareware (although other files or 
functions may require subscription).  You may send questions or comments 
to me on The Researcher's BBS and Expanding Horizons - address your 
comments to "Angelo Babudro" (I use "Angelo" to avoid gender confusion, 
and I'm used to both names anyway).  Scan for the file name WJS*.* to 
locate the latest version.

West Coast Researcher's BBS (CA) USR Dual (805) 949-8151
Enter "J;136" to join the OrganicSftwr conference then use 
"F" to list files and "E" to post messages for me.  Over 4 
gigabytes of files on-line; anything you want is here.  
Messages can be sent to this board for me via FidoNet 
1:102/1310.

Expanding Horizons (CO) 14.4k V.32 (303) 241-2847
This is my local BBS so it is the one I most often update and 
check for messages.  Log on to this board with the name "OC 
WIZ" and the password "WHAT" - this will bypass the usual 
questionnaire so you can begin downloading right away.  
Next, enter "J;3" to join conference #3, then type "F" to view 

--



What Job Summary?

the list of my software.

Midwest Rusty 'n Edie's BBS (Ohio), six phone numbers:
HST 16.8 (216) 726-1804
Hayes 28.8 (216) 726-3642
Hayes V-series (216) 726-3610
2400/V32/ZyXEL 19.2 (216) 726-2620
USR HST Turbo 21 (216) 726-3628
CompuCom Speed (216) 726-3584

East CoastExcalibur (Central NY) USR Dual (315) 736-3792
FREQ (File REQuest) from this board via RBBS address 
A:954/401, FIDO address 1:26501, or ICN address 
91:315/101.

WhiTech BBS (NC)ZyXEL 14.4 V32b/V42b (910) 944-1165
File Request (FREQ) via Fido address 1:3636/2.

Software Creations (MA) - over 120 lines.  Home of Night Owl 
CD-ROM.

USR Courier 2400 MNP5 (508) 365-2359
USR Dual Standard 14.4k (508) 368-7036
USR HST/Dual Std 16.8k (508) 365-2032
USR Dual Std v.32Terbo (508) 368-6604

ORDERING METHODS, AND REGISTRATION FEES

Years of effort have gone into this software in the hopes that many 
people will be willing to pay for a small part of the development.  Kindly 
remember that if you use this software past the 60-day trial period 
you are asked to pay the registration fee.

Benefits of Registration

The Shareware (unregistered) version of WJS is fully functional so that
you may try all of its features and know exactly for what you are paying.  
Past the 60-day evaluation period WJS will display reminders to register your 
copy or discontinue use of the software, but it will always continue to be fully
functional.
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When you register you have the following benefits:

- You get the latest version direct from the author with automated 
installation and bonus Shareware & Freeware.

- You get a complete introductory course in using computers for 
business which includes sections on hardware, software, and DOS in addition 
to WJS.

- Telephone support - you can talk to the software author who can 
help you right away and is committed to making the software work well for 
you.

- Updates are free - get them from a local BBS or vendor.  As new 
features are added, WJS' price is sometimes adjusted to reflect the dramatic 
increase in its value to users.  By registering now, you pay the current (low) 
price and are entitled to the higher-priced features.

- You can subscribe to receive new versions as soon as they are 
released so you will always have the latest features and enhancements.

- The Shareware License display and Unregistered Edition delay go 
away.

- It rewards the author for thousands of hours of software 
development done without pay and from which you are deriving benefit.  It's 
the right thing to do and will surely come back to you in blessings & good 
karma.

How To Order

Send cash, check, or money order in U.S. funds; Canadian cheques or 
foreign cash are also acceptable.  No Purchase Orders please; instead use 
the invoice (below) and, since you are and have been using the Unregistered 
Edition, consider it the case that you are paying for delivered merchandise.

If you prefer to use a credit card, you can order WJS from Public 
(software) Library with your MC, Visa, AmEx, or Discover card by calling 800-
242-4PsL (from overseas: 713-524-6394) or by FAX to 713-524-6398 or by 
CompuServe to 71355,470.  THESE NUMBERS ARE FOR ORDERING ONLY.  I 
CANNOT be reached at those numbers.  To contact me for information about 
dealer pricing, volume discounts, site licensing, the status of shipment of the
product, the latest version number, or for technical information, call 303-527-
6756 or write me at PO Box 132, Paonia, CO USA 81428.  With Shareware 
you try the software before buying it; therefore, product returns are not 
allowed.
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When ordering from PsL ask for product #11519.

Pricing

Use License with Disk, Manual, and Computer Course — $99.  License 
to use one copy of WJS along with the latest Registered Edition on 
disk with automated installation, the latest version of documentation 
on disk, notification of updates & upgrades, and a printed 3-ring-
bound manual.  The manual contains an introductory course in 
computers plus a complete guide to using WJS.  The course covers 
computer components (hardware), DOS & software basics, etc. 
Companion course disks are also provided.  This course is for the 
newcomer and covers all the topics necessary to understand and 
maintain your computer.  Manuals are printed on tree-free paper (50%
hemp/50% cereal straw).

Wholesale & OEM — If you want to bundle WJS with your own special 
product or service and resell it, please write to me with your idea.

Site License ── If your firm has multiple computers on which WJS will be 
installed you may opt to purchase a Use License (above) plus a site 
license.  With a site license you are provided with a disk for each 
computer but just one printed manual which may be photo-copied 
(although additional copies may be purchased).  Use the Help/Site 
License option on the WJS menu to print a Site License form.

Free Updates — When you register I will send you a "key" which will work 
with future releases.  You can download updates from a bulletin board
or otherwise obtain an update and it will recognize your registration 
"key".1

Updates Though the Mail — An update disk with the latest versions of all 
my shareware costs $4.00 plus shipping.  Updates are released every 
1-4 months.

Update Subscription ── You can subscribe to receive updates 
automatically through the mail.  In return you agree to send $4 plus 
shipping within 15 days.  There is no time commitment; either party 

1Be sure to delete CONFIG.WJS from copies you share with BBSs and others. 
Not only does it contain all the settings on your system and certain pieces of 
your data, it also contains your registration key and your name.
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may cancel at any time with written notice.

Prices & specifications are subject to change without notice.  Vendors 
& sysops please see VENDOR.DOC & SYSOP.DOC.

Give & Receive Support - Register the software you use
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INVOICE & REGISTRATION
Credit card orders see "How To Order" above

REMIT TO: FROM:

Angel Babudro Name___________________________
"Organic Computer Wizardry"
PO Box 132 Company________________________
Paonia, CO  81428
USA Address________________________

_______________________________

Phone__________________________

Use License Registration & disk ($99) _______ 

Shipping & Continental U.S. - add $3
Handling Canada, AK, HI, VI, PR - add $5

Outside U.S.A. & Canada - add $9 _______ 

** T O T A L  = $_______ 

Send new updates every 1-4 months and bill me $4 
plus shipping.  I will send payment within 15 days or 
return the disk to cancel this service.

Initials_______ 

Disk size & quantity [__] 3½" [__] 5¼"
Drive density [__] Low (DD) required [__] High (HD) ok
FDFORMAT/FDREAD [__] FDFORMAT extended densities okay

Printer make(s) & model(s)______________________________________

Which version are you using now? (see Help/About screen)________
I got my copy from _____________________________________________
I saw a review in_______________________________________________
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Upon receipt of this paid invoice the latest Registered Edition disk and any 
options ordered above will be sent.  Mail with your cash, cheque, money 
order in U.S. funds; Canadians may send Cdn$.  Put comments on back.  
Allow 1-4 weeks for the latest version to land on your doorstep.  Thank you 
for registering!
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WHAT DOES THIS SOFTWARE DO?

What Job Summary? is a tool to help you keep track of jobs for which 
you are contracted or sub-contracted.  WJS gives you an easy way to track 
summary information about your jobs; the estimating and details are left 
entirely up to you.  WJS then provides reports for the banker and bonding 
company as well as to help analyze your work load.

WJS can track up to 2.6 million jobs per year, which is a limit of the 
numbering system used; your practical limit will be determined by your 
computer speed & hard disk capacity and will probably be in the under-
10,000-jobs-per-year range.  For each of these jobs WJS has a place to enter 
the relevant bid, cost, and income figures - somewhat like a spreadsheet.  
Since WJS is not an estimating or billing package, it seems reasonable to 
assume that you will have total amounts calculated from another programme
(or by hand).  For this reason, WJS does not attempt to duplicate the 
functions of these other software packages, but rather it takes totals and 
puts them all neatly in one place and prints reports which are probably not 
available in your other software packages.

The function keys are the same as the Timberline estimating package.
Whether or not you are familiar with Timberline estimating, keep an eye on 
the bottom of the screen for function key definitions.

SYSTEM REQUIREMENTS

Any PC-compatible computer with at least 350k of free RAM should 
work fine, however a 286 or better and a hard disk are preferred since WJS is 
a data base application which inherently involves a lot of disk access.

WJS has been tested on MS-DOS 3.3, 5.0, and 6.2.  It should work 
properly under PC-DOS or MS-DOS version 3.1 or later although I recommend
only 3.3 and 5.0 be used -- it's worth the money to upgrade.  WJS's operating
speed is quite acceptable on an 8MHz 80286 computer.  You will need about 
240k of disk space for WJS and its necessary files plus disk space for the 
information you will enter.  Any dot matrix printer should work fine.  If yours 
isn't on the list, try one of those that are - most use similar codes, the 
biggest variant being font codes.  If your printer won't work with what is 
there, please tell me and your registered edition (or update) will include your
printer.
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Theoretically, WJS can accommodate 2.6 million jobs per year and 
each job can have up to ten lines.  WJS uses 109 bytes per line of data, so 
you will need 11k to 107k of storage per 100 jobs entered depending on the 
number of lines used.  Data base applications, such as this one, tend to 
access the disk frequently so it is much better to use a hard disk, but WJS 
can run on a floppy.  In its minimum configuration, WJS requires about 216k 
of storage, so a 360k floppy disk will have room for about 1,300 lines of data.

Using With MS Windows

WJS can be run as a DOS application under Windows 3.1 although it is
not a Windows application (in other words, it runs the same in DOS or 
Windows and you cannot use any of Windows' features with WJS, such as the 
clip-board).  If you don't use Windows or use it only occasionally (as I do), 
then use WJS from DOS since it will work faster without Windows' overhead.  
If you normally have Windows loaded, however, then go ahead and set up an
icon for WJS.  To do this, highlight or create a group (i.e., pop open a group's 
window or use the File/New option to create a new group), then use File/New 
to create a program item and define it as C:\WJS\WJS.EXE (or whatever 
directory you are using) and set the data directory to C:\WJS or some other, 
as you desire.

Using With 4DOS

WJS has been tested with 4DOS versions 4.0 and 5.0.  There are no 
special needs or considerations.

RUNNING What Job Summary? FOR THE FIRST TIME

   If you received your copy of WJS on disk it has an installation programme 
on it.  Using INSTALL is faster than setting up manually, and it won't change 
your AutoExec or CONFIG, so I'd suggest:

1. Put the floppy in a drive
2. Type "d:INSTALL" where "d:" is your drive (e.g., "A:")

INSTALL is not necessary, however.  If you have received WJS from a 
bulletin board then you have installed it by unpacking the archive.  I strongly 
suggest that you put the software in a directory of its own (for example, C:\
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WJS).  You can run the package from any directory since data files will be 
created if they are not present.  In this way you can also keep more than one
set of data files by using different directories.

Documentation Files

If you have WordPerfect 5, just load WJS.WP.  Instructions for re-
formatting are in a comment at the top of the document.  If you don't have 
WordPerfect 5 or a way to convert the WJS.WP file to your word processor, 
then use WJS.TXT which is an ASCII file generated from WordPerfect for a 
"standard printer."  Your printer should be set to CR/CR (carriage return does 
NOT produce a line feed), which is the most common setting.  If you see 
double printing of titles change this setting.

After INSTALL is finished you can type "WJS" to start What Job 
Summary?.  The "WJS" command runs a batch file which merely changes to 
the proper drive & directory then runs WJS.  You can delete this file if you are 
using a menu or would rather type the commands yourself.

Using the Menus

WJS employs the familiar, standard 2-dimensional pull-down menu 
system.  There is a horizontal menu of choices — File, Data Entry, etc.  Under
each of the horizontal choices is a menu of functions pertaining to that item 
— it is a two-dimensional menu, in other words.

There are three ways to select an item from the menu:

1. Press the letter which is highlighted in the option description
2. Use the Up/Down/Right/Left arrows to highlight the option you 

want then press ENTER (a.k.a. RETURN or CR)
3. Use a mouse to select the option you want (click with the left 

button)

Some sub-menus (such as the Help Index) do not have highlighted 
options.  On these menus you must use the arrow keys to highlight your 
choice then press ENTER.

If you want to cancel an operation you selected, just press the Esc 
("Escape") key.
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Quick Start

Type "WJS" and press ENTER; press "P" (Preferences) and go down the
list of choices, setting each screen as you see fit.  There is on-line help which
can be accessed by pressing the F1 key while on any data entry screen or via
the "Help" menu's "Index" option.

FILE MANAGEMENT AND EXIT

The choices under the File menu have to do with your system set-up, 
file management, and ending the programme.

Year-end Close-out

The purpose of this function is to remove jobs history from the files, 
thus freeing up disk space.  When you select this option you a window will 
open with three fields to fill in:

1. Cut-off year (assumes current year minus 2) - All data during or 
before this year will be erased from the file.

2. Keep pending jobs on file - If you answer "Y" (Yes) then jobs with 
a "P" (pending) status will be kept on file, regardless of their bid date.

3. Report to printer - If you answer "Y" (Yes) then all jobs which are 
removed from the file will be printed.  An audit trail, if you will.

Rebuild Indices

This function is provided in the event you ever have a power outage 
or for some other reason the index files become damaged.  If you notice 
anything strange -- like dates are in the wrong order, records are 
mysteriously missing, etc. -- just rebuild the indices and they'll probably go 
away.

Making Back-up Copies of Your Files

Your computer is a machine and one day it will probably break down.  
File/Back-up protects your information by making a copy of it on another 
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disk.

You must have a formatted disk ready.  You can use the same back-up
disk over and over again (the new copy will over-write the old one), but it is a
good idea to alternate at least three back-up copies just in case you have a 
problem while creating a back-up, in which case you have two copies on 
which you may rely.  When the work you've done since your last back-up 
would be heart-breaking to lose, it's time to make another back-up.

Using compression software packs more information in less space (so 
you can use fewer floppy disks) but requires more memory (RAM).  The 
compression software WJS is programmed to use and their memory 
requirements are as follows:

ARJ 2.41 needs at least 300k free
LHARC 2.13 needs at least 189k free
PKZip 2.04g needs at least 157k free

After you select File/Back-up a summary window pops open and a 
menu of methods will be presented, starting with "DOS Copy" and including 
each compression technique for which you have enough free memory.  Once 
you choose a method you are asked to enter the back-up destination (which 
is typically a floppy disk drive, such as A:, but you may decide to back-up to 
another hard disk, a network drive, etc.).  All WJS data files will then be 
backed-up to the destination disk and directory using the method shown in 
the window.

Restoring Files from a Back-up Copy

If you ever need to recover data files from a floppy disk you made 
using the File/Back-up command (above), just place the floppy disk in its 
drive and select File/Restore.  The first thing you will be asked is to specify 
the disk drive from which to restore files.  Once you highlight a drive and 
press ENTER the list of files on that disk will be shown - individual data files 
as well as any compressed archives.  Highlight each file you wish to restore 
and press the SpaceBar key; you will see an arrow appear next to each file as
it is selected.  If you change your mind, just press the SpaceBar again and 
the arrow will go away, indicating that the file will not be restored.  
Alternately, you may use the mouse and click the left button instead of using
the arrow keys and SpaceBar.
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Once you have selected all the files you wish to restore press the 
ENTER key or click on the "Ok" button with a mouse.  Each file will be copied 
into the current data directory.2  Any compressed archives being restored will 
automatically be expanded.

Formatting Floppy Disks

This option is for those times when you have decided to make a back-
up copy of your data but don't have a formatted disk handy or want to re-
format a disk to check for any bad spots.  File/Format Floppies lets you 
format a floppy disk to your computer's standard density without exiting WJS.
By "standard density" I mean that if you have a high density drive you can 
only format high density disks (in other words, WJS doesn't pass any 
parameters to DOS FORMAT).  There is an exception to this:

If you have What Floppy Format? (WFF.EXE) available somewhere in 
your DOS search path, WJS will automatically access it for formatting floppy 
disks so you can format any kind of disk using FDFORMAT.  (You will receive a
complimentary copy of the latest version of WFF with your WJS registration.  
FDFORMAT is a Freeware product by another author and can be found on my 
support BBSs.)

DATA ENTRY ("JOBS")

The Jobs menu of What Job Summary? lets you enter the data 
pertaining to your jobs.  There are two data entry screens:

1. General job information (number, name, bid amount, estimated 
cost, and bid due date)

2. Cost figures (bid amount, original estimated cost, cost to date, 
billed to date, revised estimated cost)

NOTE:  You must first create a job on the General screen 
before you may access it on the Cost Figures screen.  New jobs
can only be added on the General screen.

2The directory from which WJS is started is considered the data directory - it 
is where the data files are stored.  For example, if you are in the C:\WJS\DATA
directory and you run WJS from there, then files will be created in, backed-up
from, and restored to this directory.
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Notice the available function keys at the bottom of the screen: F1 
always saves and ends the current operation (e.g., if you are entering 
a line of information for a job, pressing F1 will save the line and end 
data entry for that job).  F2 always cancels the current operation 
without saving (old values are restored) (e.g., if you are entering 
changes to a line and press F2 the old data for the line will be 
restored and data entry for that job will be ended).

Entering New Jobs

While on the General screen press the Ins (insert) key.  The cursor will
"jump" to the bottom of the window and wait for you to start entering 
information.  WJS will attempt to guess the next job number based on the 
default job letter (defined on the Preferences/Fiscal Year screen), the current 
fiscal year (defined on the Preferences/Fiscal Year screen), and the last job 
number on file for that letter & fiscal year.  Press ENTER after each item you 
enter.  Use the up and down arrow keys to move between the fields and the 
right/left arrows to move around within a field.

Editing Existing Jobs

To change information on either the General Info or Costs screen just 
highlight the line you want to change and press ENTER.  You can then change
anything on that line except for the job number (Job numbers are key items 
in the files and can't be changed).  If you must change a job number you will 
have to delete and re-enter the information.

Job Codes

Each job must have a unique identification code.  Each job code may 
have one to ten lines of information.  Each line may have it's own status, 
dollar amount, and bid due date.  This allows you to group separate elements
of a similar job together under one job code.  For example, let's say you are 
bidding on a job that will take several years to complete and has been split 
into four phases; you are bidding separately on each phase.  When you enter
the job you can put a "Phase I" line, a "Phase II", line, etc. and enter the 
dollar amounts, status, and bid date for each phase.  If you get two of the 
bids just mark those two phases as "Y" (yes) and the other two as "N" (no).

The format of a Job Code
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Job codes are entered in the format "A#####" where "A" is a 
letter used to segregate jobs (perhaps different departments in your 
organization, different companies owned by a larger corporation, or 
for different types of jobs) and "#####" is a job number from 00000 
to 99999.  I recommend that you use the format "Ayy###" where 
"yy" is a two-digit year, or the format "Ay####" where "y" is a one-
digit year.

Using this format of job numbering gives WJS a simple but 
effective and flexible means to separate jobs.  If you have no need to 
separate your jobs just make them all one letter such as "A" or the 
first letter of your name.

When you add new jobs WJS will automatically supply the next 
available job code based on the default job letter & fiscal year 
entered on the Preferences/Fiscal Year screen.  You can type over this 
with a new job code as necessary.

How Many Jobs Can I Track?

The filing system used by WJS can store 5.5 million records per 
file.  Since each line is a record this gives WJS a theoretical limit of 5.5
million lines of job information, although even the fastest PC would 
have trouble with a file that large.  (See System Requirements, above,
for disk storage requirements.)

Practically speaking, then, WJS is unlimited except by your hard 
disk and computer speed.  The rule of "Ayy###" works well, but if 
you have more than 26,000 jobs per year or if you need to have more 
than 1,000 jobs under a letter then you can make up your own 
numbering scheme.  A good alternative would be to use a single digit 
year (Ay#### - for example, J21001 for department J, year 1992, job 
#1001) which would give you 260,000 jobs per year for ten years.  
Whatever numbering scheme you use, remember that each job must 
have a unique code.

Dollar Amounts

Enter currency figures without any symbols, such as commas.  The 
only non-numeric character allowed is a period/decimal point.

--
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Bid Date

Enter the bid date in the form "mmddyyyy" (month/day/year).  For 
example, "01011992" is Jan. 1, 1992.  The slashes are entered for you.  Be 
sure to fill in all numbers, even zeros — "1192" won't work for 1/1/92 -- enter 
"010192" instead.

REPORTS

Rather than describing each report here, it makes more sense for you 
to print a sample of each.  Just highlight the one you want, follow the 
instructions on the screen.  The Status Report has a sub-menu from which 
you must choose one or more report options.  The Work On-hand/Completed 
report has a sub-menu for which one item must be chosen.

One note: I have chosen to use the extended graphics characters 
(ASCII 127-254) rather than use the rather crude vertical bars (|), plus signs, 
etc. for the reports.  Most printers made after 1982 are able to print these 
characters and it allows WJS to print nicer looking reports.  If you experience 
problems (e.g., you see a line of italic Ms or Ds where a horizontal line should
be) look in your printer's manual for a Character Set 1 or 2 setting, which 
may be a DIP switch or a front panel menu setting, and change it.  If you 
have trouble you can call me and I'll try to help.

PREFERENCES

The Preferences menu contains options which help you customize the 
operation of WJS and set necessary parameters, such as the type of printer 
you have.  Please check each Preferences screen before making full use of 
WJS, otherwise something might seem wrong with the software whereas it is 
due to the set of conditions under which WJS is operating.

Settings: Back-up Method, Country, etc.

Under the File menu is an option which allows you to back-up & 
restore your data to/from other disks for safety.  These operations will use 
the DOS COPY command unless you use this option to change it.

You will see a menu of four choices of methods to use when backing-
--
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up and restoring:  DOS COPY (the default), ARJ, LHARC, or PKZIP.  In order to 
use ARJ, LHARC, or PKZIP compression software you must have the 
compression programme available in your DOS PATH.  In addition, you will 
also need enough free memory (RAM) to run both WJS and the compression 
software.

Country setting

WJS does not yet make use of this setting, but I have put it in the 
menus for near-future use.

Fiscal Year

To give you a report of your job activity for your company's fiscal 
year, WJS needs to know the beginning month of your fiscal year.  Select 
Preferences/Fiscal Year and enter the beginning month number (1 for 
January, 2 for February, etc.).  Highlight the "Ok" button and press ENTER or 
just press F1 (function keys are shown at the bottom of the screen).

WJS assumes you have a wide-carriage (15-inch) printer for the Work 
On-hand/In progress reports since it is a 200+ column report.  If you have a 
10-inch (narrow carriage) printer you won't be able to print the Work reports. 
On a laser printer you can manually set the printer for landscape mode and a
small font like Line Printer.

Defining your Printers

Before you can print anything you will have to tell WJS which printer 
you will use.  WJS can print reports on PCL lasers or dot matrix printers, 
although the Work On-hand/Completed reports are so wide that they require 
15-inch paper or a very, very tiny font.  Until you define your printer(s) and 
font(s) there will be a flashing message at the bottom of the screen and you 
will not be able to print anything.

The Printer definition window shows the current settings.  Use the 
arrow keys to move around, and press the F3 key to change anything.  For 
example, to set your printer move the cursor down to that line then press F3 
and a menu of choices will appear.  Highlight your printer (or one compatible 
with it) and press ENTER.  Then move down to the font definition and press 
F3 again.  Highlight your font selection and press ENTER.  When you are 
finished, highlight the "Ok" button and press ENTER.  Alternately, you can 
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press F7 to save the screen and exit.

Default Directory for Laser Printer Soft Fonts

If you define a laser printer you can set a default soft font 
directory by highlighting this field and pressing F3.  Enter the 
directory name on your hard disk (e.g., "D:\VENTURA\") which 
contains your soft fonts.  WJS will check to see if the directory name 
you entered is valid and if it exists, and will inform you if not.  Then, 
when you set fonts for printing, you can choose the "Soft font" option 
and select from your fonts on disk.

HELP

The Help menu has two options:  About and Index.  "About" gives 
some information about the programme and free memory.  Index gives a 
menu from which you may choose a topic and press ENTER, whereupon a 
helpful window of information will appear.  :)  It's a handy (albeit brief) on-
line manual.

PROBLEMS AND ERROR MESSAGES

WJS tries to handle most problems without any attention from you, 
however, there are times when an error happens which WJS is unable to 
handle.  There are three types of errors which you may experience:

1. Condition error - this is a problem due to an operating condition.  
Examples of this type of error are if a printer is off-line when you try to print 
or if a file is locked by another user on a network.  WJS will report the 
condition in a window and, once you press ENTER or click the "Ok" button 
WJS will continue operating.

2. File error - these problems cause an error screen to appear which
suggests a possible solution to the problem and, if you can't fix it, my 
address and phone number is shown so you can contact me.  A common 
reason for this error is that an index file contains a bad entry (perhaps due to
a power outage).  The most common solution to these problems is to re-
index your files (File/re-Index).
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3. Programme error - this is a mistake of mine and will cause the 
programme to abruptly end with a one-line error message and a message 
like "Press any key to return to system."  Report these errors to me right 
away, please.  Just like other large software packages, WJS contains 
hundreds of thousands of instructions and the bigger it gets the more likely it
is that a "bug" will creep in there somewhere.  These errors get top priority 
and are usually fixed and a new version released within a day.

If anything happens that you don't understand, or if you can't get WJS
to do what you want, I would appreciate knowing about this so I can fix the 
software or update the documentation as necessary.

Most software of any significance has "bugs" which are errors of logic 
in the programme.  PC-DOS, MS-DOS, and Windows all have "bugs" which 
can cause problems.  As WJS goes through its evolution, bugs are removed; 
as new features are added new bugs sometimes find their way into the 
software.  I place great emphasis on keeping data safe and know of no 
person who has ever lost data due to a problem in WJS.  However, problems 
with DOS or computer equipment may cause data to be lost in rare 
circumstances.

If any of your data seems to be missing exit to PC-DOS (or MS-DOS) 
and type "CHKDSK d: /F" (without the quotation marks and replacing "d:" 
with the drive on which you store your WJS files, such as "C:").  If you are 
using MS-DOS version 6 or later, use the command "SCANDISK d:" (without 
the quotation marks and replacing "d:" with the drive on which you store 
your WJS files) since it performs a more thorough test.  These commands will 
check your disk for any problems pertaining to the files on them.  The 
SCANDISK utility can also perform a surface scan which tests the entire disk 
to be sure all areas of it are usable.

If CHKDSK or SCANDISK find any errors they will be reported to you 
and you will be asked for input on correcting the errors.  CHKDSK only knows 
how to clear any errors and turn "orphan" data into new files.  By "orphan" 
data I mean data which is on your hard disk but for which DOS has lost the 
information about the file to which it belongs.  Normally this data is not 
usable or requires tremendous effort to make it usable again.  I suggest you 
do not create files from this data unless you have lost a tremendous amount 
of data which would be very difficult to re-enter or the data is irreplaceable.  
Beyond this point you will require the help of someone who knows how to 
recover damaged files.  Contact me if you cannot find a local consultant to 
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perform this service for you.

SCANDISK is able to identify bad sections of your disk and attempt to 
move data to safe areas.  If the area is badly damaged the attempt to move 
data may not be entirely successful.  If SCANDISK tells you it has found 
problems on your disk I suggest you let it fix them.  If your data is 
irreplaceable or would take a tremendous amount of effort to re-enter, then I 
recommend that you get the help of a consultant.  At the very least make a 
complete back-up copy of your data files (or the entire hard disk) so that you
can attempt to restore information in case files are so badly damaged that 
information becomes lost.

In most cases you will find that no data is missing and all you need to 
do is re-index your files for the "missing" entries to re-appear.  To re-build the
index files just select the Re-index option on the File menu.

FILES WHICH MAKE UP THE PACKAGE

What Job Summary? consists of the following files:

file_id.diz * Description file for BBSs
desc.sdi * Description file for BBSs
WJS.EXE The executable file
WJS.HLP The help file
WJS.TXT * The ASCII file of this document
WJS.WP * WordPerfect 5 file of this document to format for your

printer
READ.ME * A file containing late-breaking news
ORDER.FRM Order form for all of my software — please "TYPE 

ORDER.FRM > PRN" to print it
PRINTER.DAT Printer "driver" file
SYSOP.DOC * Registration offer for BBS sysops
VENDOR.DOC * WJS distribution information

These are the files which make up WJS.  If you distribute evaluation 
copies to friends and bulletin boards please be sure to include all of these 
files.  Additional files will be created in the same directory as you use the 
software.  The files marked with an asterisk (*) can be deleted if disk space is
a premium, but I ask that you please keep ORDER.FRM on disk until you 
decide whether or not to register.
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Registered users — please keep the file CONFIG.WJS only for yourself 
as it contains your registration key and system settings.  Share only those 
files listed above.
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